Creating an Excel Database

In an Excel database each column is a field of data and each row one record. Excel will treat a block of contiguous data as a database. Microsoft use the term list and database interchangeably in Excel.

It is important to use the following rules when creating an Excel database; if they are not followed you may cause yourself problems later on.

Database Rules:

- **Field headings**: As each column is a field, place a heading in the first row. Format these so they look different to the rows of data (e.g. Bold). Field headings must only occupy 1 row.
- **Empty rows**: Do not leave an empty row across the middle of the database; Excel will not see the two halves as the same list. At the end of the list make sure that the next row is empty, this tells Excel it has reached the end of the database.
- **Empty column**: You can leave a column empty of data, so long as it has a heading. At the end of your list make sure that the next column is empty, this indicates to Excel that it has reached the end of the database.
- **Empty cells**: You can leave a cell empty within the database, this just indicates that you don’t have data.
- **Other lists**: Don’t keep more than one database to a spreadsheet. In fact don’t use the sheet for anything else.
- **Keep data small**: Avoid putting too much data in any one field, e.g. have a First Name and a Last Name field. You can then sort by either one. Break up Address information into Street Name and Number, County and Post Code fields.

**AutoFilter**

Auto-filtering allows you to find records that match with specific criteria.

**Finding an Exact Match**

1. Select a cell in the database
2. On the Data tab
3. Click the Filter button
4. Click the arrow in the column that contains the values you want to filter, and use the tick boxes to select which values you want to filter by. The example below will only show records with a department of **Training**
5. Click OK

**NOTE** If your data is a list of dates then you can select to expand the Years and select Months or even specific dates. Click the + signs to expand Years or Months and tick the desired option. You can also use the Search box to filter specific dates or values.

**TIP**: When you apply a filter to a column, the only filters available for other columns are the values visible in the currently filtered range.

**Number Filters**

1. Click the arrow in the column that contains the numbers, and click **Number Filters**
2. Click on the filtering option you want
3. For all options except Above and Below Average the options list disappears and the rows that do not match your criteria are hidden
**Date Filters**

1. Click the arrow in the column that contains the dates, and click **Date Filters**
2. Click on the filtering option you want
3. For all options followed by an ellipsis (…) the Custom Filter dialog box opens, see Custom Filter below to complete the steps
4. For **All Dates in the Period** a sub menu appears allowing you to select a **Quarter** or a **Month** for your filter. For other date ranges select **Between** and follow the steps below under Custom Filter
5. For options without an ellipsis (…) the options list disappears and all rows that do not match your specified criteria are hidden

**Text Filters**

1. Click the arrow in the column that contains the text
2. Select **Text Filters**
3. Pick an option from the menu
4. Follow the steps below under Custom Filter

**Custom Filter**

Many options from the data filter menus will result in the Custom AutoFilter dialog box opening

5. If you come to the Custom AutoFilter dialog box by selecting an option such as Greater Than or Between the left hand fields will already be filled in with the required range operators. You must then complete the data criteria on the right hand side.

**Filter for Blank or Nonblank Cells**

1. Click the arrow in the column you wish to filter
2. Untick all data selection options other than (Blanks)
3. Click **OK**

**Filter for the Top or Bottom Numeric Values**

1. Click the arrow in the column that contains the numbers
2. Select **Number filters**
3. Select **Top 10...**
4. In the box on the left, click **Top** or **Bottom**
5. In the box in the middle, enter the number of values you want
6. In the box on the right, click **Percent** or **Items**
7. Click **OK**

**Seeing what filters are being applied**

You can tell when a column/field has a filter being applied to it as the arrow symbol is replaced with. Hover the cursor over the symbol and a message box gives details of the filter

**Remove AutoFilters**

- To remove a filter applied to one column in a range or a list, click the arrow next to the column, and then click **Clear Filter From “xxx”**.
- To remove the filter arrows from a range or list, click the Filter button

**Sorting Data**

**Sorting A-Z and Z-A**

When you sort data in a column you in fact move the content of the whole row up/down the list. This ensures that all data in a row (record) stays together.

1. Click a cell in the column by which you wish to sort
2. From the **Sort & Filter** group click either **Sort Ascending** or **Sort Descending**.

---

**Note**: If you are using a date formatted field the dialog box will contain a date picker button to make it easier to enter date information.
Excel 2013 - Introduction to Excel Databases & Data Tables

TIP: To sort by more than one column, click the Sort button in the Data tab and add each level that you want to sort by. The order of sorting can be changed using the Up/Down buttons in the Sort box.

Excel’s Ascending Sorting Order
- Numbers are sorted from the smallest negative number to the largest positive number.
- Dates are sorted from the earliest date to the latest date.
- Alphanumeric data is sorted left to right, character by character. For example, if a cell contains the text "A100," Excel places it after a cell that contains the entry "A1" and before a cell that contains the entry "A11."
- Text and text that includes numbers are sorted in the following order:
  0 1 2 3 4 5 6 7 8 9 (space) ! " # $ % & ( ) * , . / : ; ? @ [ \ ] ^ _ ` { | }
  ~ + < = > A B C D E F G H I J K L M N O P Q R S T U V W X Y Z
- Apostrophes (’) and hyphens (-) are ignored, with one exception: If two text strings are the same except for a hyphen, the text with the hyphen is sorted last.
- Logical values sort with FALSE placed before TRUE.
- All error values are equal.
- Blanks are always placed last.

Custom Sort Order
If your data needs to be sorted but not alphanumerically then you can create your own sort order.

Creating & Using a Custom Sort Order
1. Click in the database
2. Click the Sort button
3. In the Sort dialog box, under Column click on the Sort by drop-down menu and select the field to use the custom sort order
4. Click the Order drop down menu
5. Select Custom List … to open the dialog box below
6. Click in the List Entries field
7. Type in the entries you wish to have in the custom order, in the order by which you want them to be sort. Use the Enter key after each to move to the next line
8. Click Add
9. Click OK
10. The custom entry will be selected as the sort order for that field.

TIP: Custom sort orders become part of Excel and can be used in any workbook. Excel already has custom sort orders as seen in the dialog box above step 6

Sorting Left to Right
The default sort order is from top to bottom but Excel can sort left to right.
1. Click a cell in the range you want to sort.
2. Select the Data tab
3. Click the Sort button
4. In the Sort dialog box click the Options button
5. Click Options
6. Under Orientation, click Sort left to right, and then click OK
7. From the Sort by field select the row you want to sort by
8. From the Order field select a sort order, A-Z or Z-A
9. Click OK

TIP: If you have formulas in your database make sure that each formula and the data it uses remains in the same relative positions e.g. if the data is a column A and the formula in column B, when they are sorted left to right the formula must be one column to the right of the data.
**Excel 2013 - Introduction to Excel Databases & Data Tables**

**TIP:** If you don’t want to sort the data by any existing headings or data then insert a row above your headings, put a number above each column to indicate the new order of the columns. Select all the data (use Ctrl + Shift + *). Use the Sort Option dialog box as explained above but in step 5 use the row with the numbers in or the Sort by field.

### Using Data Validation

Use Validation rules to ensure that data added is acceptable.

#### Create a Validation Rule

1. Select the cell or range to validate
2. On the **Data** tab, in the **Data Tools** group click the top half of the **Data Validation**
3. In the **Validation** dialog box click the **Settings** tab

![Data Validation Settings](image)

4. Specify the type of validation you want:

**Allow Values from a List**

1. In the **Allow** box, click **List**.
2. Click the **Source** box and then do one of the following:
   - To use cell references, select the cells on the worksheet and then press ENTER. The cell references have to be to cells on the same worksheet. If you have to refer to a different worksheet or a different workbook, use a defined name.
   - To define the list in the dialog box, type the list values separated by commas.
   - To use a range of cells with a defined name, type the equal sign (=) followed by the name of the range. If the defined name is in another workbook ensure that workbook is open while creating the Validation rule.

3. Click **OK**

**Allow Numbers within Limits**

1. In the **Allow** box, click **Whole Number** or **Decimal**.
2. In the **Data** drop-down, select the type of restriction you want. For example, to set upper AND lower limits, click **between**.
3. Enter the minimum, maximum, or specific value to allow.

**Allow Dates or Times**

1. In the **Allow** box, click **Date** or **Time**.

2. From the **Data** drop-down, click the type of restriction you want. For example, to allow dates after a certain day, click **greater than**
3. Enter the start, end, or specific date or time to allow
4. Click **OK**

**Allow Text of a Specified Length**

1. In the **Allow** box, click **Text Length**.
2. In the **Data** drop-down, click the type of restriction you want. For example, to allow up to a certain number of characters, click **less than or equal to**.
3. Enter the minimum, maximum, or specific length for the text.

**Input Message & Error Alerts**

1. To display an optional input message when the cell is clicked, click the **Input Message** tab.
   - Make sure the **Show input message when cell is selected** check box is selected.
   - Fill in the title and input message fields.
2. To specify how you want Microsoft Excel to respond when invalid data is entered click the **Error Alert** tab
   - Make sure the **Show error alert after invalid data is entered** check box is selected.
   - Select one of the following options for the **Style** box:
     - To display an information message that does not prevent entry of invalid data, click **Information**.
     - To display a warning message that does not prevent entry of invalid data, click **Warning**.
     - To prevent entry of invalid data, click **Stop**.
   - Fill in the title and text for the message.
Excel 2013 - Introduction to Excel Databases & Data Tables

TIP If you don’t enter a title or text, the title defaults to “Microsoft Excel” and the message to: “The value you entered is not valid. A user has restricted values that can be entered into this cell.”

**Remove a Validation Rule**
1. Select at least one cell where you no longer want the validation rule.
2. On the Data tab, click the top half of the Data Validation button.
3. To erase current settings click the Settings tab.
4. To remove the same settings from all other cells with the same validation rule tick the Apply these changes to all other cells with the same settings tick box.
5. Click Clear All.
6. Click OK.

**Circle Invalid Cells**
Data entered before the rule is applied are exempt from the rule. However, all cells that don’t meet their data validation criteria can be circled.
1. Select the Data tab.
2. From the Data Tools group click the lower half of the Data Validation button.
3. Select Circle Invalid Data.

**Hide validation circles**
1. Select the Data tab.
2. From the Data Tools group click the lower half of the Data Validation button.
3. Select Clear Validation Circles.

**Find all cells with data validation**
1. Press Ctrl + G to open the Go To dialog box.
2. Click Special.

**Subtotals**

**Adding Subtotals to a List**
A database may contain data you wish to summarize by group, e.g. salary total by dept, use Subtotalling.
1. Click a cell in the column by which you wish to group the data (e.g. dept) and select the Data tab.
2. From the Sort Filter group click Sort Ascending or Sort Descending.
3. From the Outline group click the Subtotal button.
4. From the At each change in drop-down, select the column you sorted by. In the example below, the Full Name column is selected.
5. In the Use function box, click the summary function you want to use to calculate the subtotals. (Examples of summary functions include Sum, Count, and Average.)
6. In the Add subtotal to box, select the check box for each column that contains values you want to subtotal. In the example above, you'd select the Commission column.
7. If you want an automatic page break after each subtotal, select the Page break between groups check box.
8. If you want the subtotals to appear above the subtotalled rows instead of below, clear the Summary below data check box.

**TIP:** To display a summary of just the subtotals and grand totals, click the outline symbols next to the row numbers. Use the [ ] and [ ] symbols to display or hide the detail rows for individual subtotals.

**Adding Further Subtotals**
You can add further functions as required.
1. On the Data tab, click the Subtotal button.
2. Select a second function.
3. To show both functions simultaneously clear the Replace current subtotals check box.
4. Click OK.

**Removing Subtotals**
When you remove subtotals, Microsoft Excel also removes the outline buttons and any page breaks that you inserted into the list along with the subtotals.
1. Click a cell in the list that contains subtotals.
2. On the Data tab, click the Subtotal button.
3. Click Remove All.

---

---
Inserting Rows and Columns

You can insert rows above a row and columns to the left of a column. You can also delete rows and columns. In the description below the instructions are for rows, for columns just replace the word row with column, and above with left.

1. Select the row(s) heading above which you want to insert the new row
2. Select the Home tab
3. In the Cells group click the top half of the Insert button

Freezing Column Headings and Row Details

Use the freeze screen feature to keep certain rows/columns in view at all times.

1. Select the View tab
2. From the Window group click the Freeze Panes button and select an option. The Freeze Panes option will freeze rows above and columns to the left of your current spreadsheet selection
3. To remove select the Unfreeze Panes

Screen Split

Screen splitting allows distant parts of the worksheet to be viewed at the same time

1. Select a cell just below where you wish to split the screen
2. Select the View tab
3. From the Window group click the Split button

4. The vertical and horizontal scrollbars are split and the top/bottom and left/right halves of the screen can be scrolled independently
5. To remove click the Split button

Useful Keyboard Shortcuts

Moving around a database can be made easier by using the following shortcuts.

- Ctrl+Shift+* - Selects the whole database
- End+↑,→,←,↓ - Moves the activecell to the end of the data in the direction of the arrow
- Shift+End+↑,→,←,↓ - Selects from the activecell to the end of the data in the direction of the arrow
- Ctrl+End – Move to the last cell on the worksheet, in the bottom-most used row of the rightmost used column
- Home - Move to the beginning of the row
- Ctrl+Home – Move cell to top left scrolling cell
- Alt+Page Down – Move one screen to the right
- Alt+Page Up – Move one screen to the left

Screen Split